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[bookmark: _Toc51146344]Purpose
Lease contracts describe contractual agreements between two partners: the lessor and the lessee. The lessor owns an asset, whereas the lessee has a right to use this asset during the period agreed in the lease contract. The lessee pays lease payments for the use of the asset, as agreed upon in the lease contract.
This scope item helps you standardize and automate your lease-out debit contract management activities for Real Estate, as well as for Machinery, Equipment, Vehicles, and Computer Hardware.
You can easily create new contracts and execute periodic postings for existing contracts.
You can change the customer of an existing contract, as well as run a report of existing contracts as part of your daily business.
You can create reminder rules for every contract, for example to check the conditions, the contract terms, renewal options, helping you to save time and effort and free up capacity for more strategic tasks.
Leveraging the reporting functions enables you to make better and more informed lease management decisions.
This scope item is applicable for operating lease of Lease Out scenarios.
This document provides a detailed procedure for testing this scope item after solution activation, reflecting the predefined scope of the solution. Each process step, report, or item is covered in its own section, providing the system interactions (test steps) in a table view. Steps that are not in scope of the process but are needed for testing are marked accordingly. Project-specific steps must be added.
[bookmark: unique_2][bookmark: _Toc51146345]Prerequisites
This section summarizes all the prerequisites for conducting the test in terms of systems, users, master data, organizational data, other test data and business conditions.
[bookmark: unique_3][bookmark: _Toc51146346]System Access
	System
	Details

	System
	Accessible via SAP Fiori launchpad. Your system administrator provides you with the URL to access the various apps assigned to your role.


[bookmark: unique_4][bookmark: _Toc51146347]Roles
Assign the following business roles to your individual test users. Alternatively, if available, you can create business roles using the following spaces with pages and predefined apps for the SAP Fiori launchpad and assign the business roles to your individual test users.
Note These roles or spaces are examples provided by SAP. You can use them as templates to create your own roles or spaces.
For more information about business roles, refer to Assigning business roles to a user in the Administration Guide to Implementation of SAP S/4HANA with SAP Best Practices .
	Name (Role)
	ID (Role)
	Description (Space)
	ID (Space)
	Log On

	Contract Specialist - Leasing
	SAP_BR_RECM_SPECIALIST
	Contract Data
	SAP_BR_RECM_SPECIALIST
	

	Accounts Receivable Accountant - Leasing
	SAP_BR_RECM_AR_ACCOUNTANT
	Accounts Receivable - Leasing
	SAP_BR_RECM_AR_ACCOUNTANT
	

	Administrator - Leasing
	SAP_BR_RECM_ADMINISTRATOR
	Administration
	SAP_BR_RECM_ADMINISTRATOR
	

	Cash Manager
	SAP_BR_CASH_MANAGER
	Cash Management
	SAP_BR_CASH_MANAGER
	

	Administrator - Enterprise Contract Management
	SAP_BR_ADMINISTRATOR_LCM
	Enterprise Contract Management Admin
	SAP_BR_ADMINISTRATOR_LCM
	

	Legal Counsel
	SAP_BR_LEGAL_COUNSEL
	Enterprise Contract Management
	SAP_BR_LEGAL_COUNSEL
	

	Configuration Expert - Business Process Configuration
	SAP_BR_BPC_EXPERT
	Business Process Configuration
	SAP_BR_BPC_EXPERT
	

	Administrator
	SAP_BR_ADMINISTRATOR
	Administration
	SAP_BR_ADMINISTRATOR
	


[bookmark: unique_5][bookmark: _Toc51146348]Master Data, Organizational Data, and Other Data
	Data
	Sample Value
	Details
	Comments

	Company Code
	1010
	
	

	Chart of Depreciation
	1010
	
	

	Vendor
	10300001
10300002
	
	

	Customer
	10100001
10100002
	
	

	Cost Center
	any available cost center with company code relation, for example, 10101101
	
	

	Profit Center
	any available profit center, for example, YB600
	
	

	Functional Area
	any available functional location, for example, YB40
	
	


You can find general information on how to create master data objects in the following Master Data Scripts (MDS):
	MDS
	Description

	BND
	Create Customer Master

	BNH
	Create Profit Center

	BNM
	Create Cost Center and Cost Center Group


[bookmark: d2e703][bookmark: _Toc51146349]Preliminary Steps
[bookmark: unique_6][bookmark: _Toc51146350]Prerequisites – Default Value for Tax Rate per Contract Type
Purpose
For each contract type, you specify here which tax group and which tax type is proposed by the system when a contract is created. For contract types that are not relevant for tax (internal contracts, G/L account contracts), you can also specify that these contract types are treated as tax exempt.
If you set the Tax Exempt indicator, then the tax type and tax group are not entered during the processing of contracts with this contract type. In that case, leave the Tax Type and Tax Group fields blank in this view, otherwise the cash flow generation would incorrectly use the tax type and tax group entered here.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log onto SAP Gui System
	Log on to the SAP Gui System as a Configuration Expert - Business Process Configuration.
	The SAP Gui System displays.
	

	2
	Enter Transaction Code
	Enter Transaction Code SPRO in Command Bar.
	The Customizing: Execute Project screen displays.
	

	3
	Open SAP Reference IMG
	Open SAP Reference IMG.
	The SAP Reference IMG screen displays.
	

	4
	Assign Tax Type and Tax Group
	Choose the following navigation option:
Flexible Real Estate Management (RE-FX) > Accounting > Automatically Generated Accounting Documents > Taxes > Default Value for Tax Rate per Contract Type
In the Default Tax Group column, verify or change your default tax group. (your default tax group, for example, Y-FULL, which is already in)
Choose Save.
To change the Default Tax Group, choose the Display/Edit button, then select the magnifying glass in the field you wish to change.
	The Valuation Rule has been assigned to company code
	


[bookmark: unique_7][bookmark: _Toc51146351]Prerequisites – Assign Tax Codes
Purpose
In this SSC-UI, you assign a tax code in your accounting system to the tax types and tax groups that you defined in Flexible Real Estate Management. The tax code is needed for calculating tax on sales/purchases. The tax code assignment is both country-dependent and time-dependent.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log onto SAP Gui System
	Log on to the SAP Gui System as a Configuration Expert - Business Process Configuration.
	The SAP Gui System displays.
	

	2
	Enter Transaction Code
	Enter Transaction Code SPRO in Command Bar.
	The Customizing: Execute Project screen displays.
	

	3
	Open SAP Reference IMG
	Open SAP Reference IMG.
	The SAP Reference IMG screen displays.
	

	4
	Assign Tax Code
	Choose the following navigation option:
Flexible Real Estate Management (RE-FX) > Accounting > Integration FI-GL, FI-AR, FI-AP > Taxes > Assign Tax Codes
Enter a tax code if it is blank.
Choose Save.
To change the Tax Code, choose the Display/Edit button, then select the magnifying glass in the cell you wish to change.
	The tax code has been assigned to company code.
	


[bookmark: unique_8][bookmark: _Toc51146352]Prerequisites – Assign Tax Code (for FI Document)
Purpose
In this SSC-UI, you assign a tax code in your accounting system to the tax types and tax groups that you defined in Flexible Real Estate Management. The tax code is needed for calculating tax on sales/purchases. The tax code assignment is both country-dependent and time-dependent.
You have to make this assignment in order for FI documents to be read correctly in RE. This assignment is relevant, for example, for service charge settlement and input tax distribution.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log onto SAP Gui System
	Log on to the SAP Gui System as a Configuration Expert - Business Process Configuration.
	The SAP Gui System displays.
	

	2
	Enter Transaction Code
	Enter Transaction Code SPRO in Command Bar.
	The Customizing: Execute Project screen displays.
	

	3
	Open SAP Reference IMG
	Open SAP Reference IMG.
	The SAP Reference IMG screen displays.
	

	4
	Assign Tax Type and Tax Group
	Choose the following navigation option:
Flexible Real Estate Management (RE-FX) > Accounting > Integration FI-GL, FI-AR, FI-AP > Taxes > Assign Tax Code (for FI Document)
Enter Tax Type and Tax Group if they are blank (for example, Y2 and Y-NONE)
Choose Save.
	The Tax Code has been assigned to company code.
	


[bookmark: unique_9][bookmark: _Toc51146353]Prerequisites – Enter Index Level
Purpose
In this SSC-UI, you can create:
1. Index class as the basis for further defining indexes for rent adjustments
1. Index series used in your organization for rent adjustments, including index series with base year
2. Index points for the index series
Standard Settings
SAP supplies the index classes 6 for real estate objects and 5 for maintenance and operating costs index (Switzerland).
Activities
1. Check whether you have to make changes to the standard setting. The Real Estate component requires the following index classes:
a) An index class for rent adjustment with the following settings:
· Details on indexing frequency (monthly: entry 2)
· Details on base year
b) Applies only for Switzerland: a class for maintenance and operating costs index with the following settings:
· Details of an indexing frequency (monthly: entry 2)
· No base year: Check if changes to the standard setting are necessary.
4. Index series
First maintain per index class the required index series and, for index series with base year, the required base years for the respective index series.
5. Index data
Create the required index data for the index series.
To do so, navigate over the required entry (index series with or without base year.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log onto SAP Gui System
	Log on to the SAP Gui System as a Configuration Expert.
	The SAP Gui Interface displays.
	

	2
	Enter Transaction Code
	Enter Transaction Code SPRO in Command Bar.
	The Customizing: Execute Project screen displays.
	

	3
	Open SAP Reference IMG
	Open SAP Reference IMG.
	The SAP Reference IMG screen displays.
	

	4
	Search and Open Enter Index Levels
	Choose the following navigation option:
Flexible Real Estate Management (RE-FX) > Adjustment of Conditions > Index Adjustment > Enter Index Levels
Open Enter Index Levels.
Select Index Classes(for example 6)
Double click Index Series and select an Index Series (for example S_DE)
In the Dialog Structure area, double click Base years for index series and select a base year(choose New Entries to add a new Base year if there has no data displayed).
Double click Index points for index series with base year.
Click New Entries, input Year, Month, Day and Index, then save it.
	The Valuation Rule has been assigned to company code
	


[bookmark: unique_10][bookmark: _Toc51146354]Prerequisites – Maintain Residence Time
Purpose
Data archiving reduces the data volume in your production system by removing data that is no longer needed for current work, but must be available in case of inquiries.
In this SSC-UI you specify the residence time 1 and residence time 2 for the data to be archived per object type.
Define Output Parameter Determination
Define Output Parameter Determination
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log onto SAP Gui System
	Log on to the SAP Gui System as a Configuration Expert.
	The SAP Gui System displays.
	

	2
	Enter Transaction Code
	Enter Transaction Code SPRO in Command Bar.
	The Customizing: Execute Project screen displays.
	

	3
	Open SAP Reference IMG
	Open SAP Reference IMG.
	The SAP Reference IMG screen displays.
	

	4
	Search and Open Define Residence Times for Archiving
	Choose the following navigation option: Flexible Real Estate Management (RE-FX) > Tools > Archiving > Define Residence Times for Archiving
Open Define Residence Times for Archiving.
Enter a value for day(s) (for example 0) for Residence time 1 and Residence time 2 for Type: REFX_CN
Enter a value for day(s) (for example 0) for Residence time 1 and Residence time 2 for Type: REFX_CNCF
Choose Save.
	The Residence Times have been added.
	


[bookmark: unique_11][bookmark: _Toc51146355]Overview Table
The Lease-Out Accounting scope item consists of several process steps provided in the following table:
If your system administrator has enabled spaces and pages on the SAP Fiori launchpad, the homepage will only contain the essential apps for performing the typical tasks of a business role.
You can find all other apps not included on the homepage using the search bar.
If you want to personalize the homepage and include the hidden apps, navigate to your user profile and choose Settings > App Finder .
	Process Diagram
	Business Roles
	Transaction/App
	Expected Results

	Create Contract  [page ] 15
	Contract Specialist - Leasing
	Manage Contract - Missing translation in language EN (RECN)
	The contract is created. The system message confirms creation and displays the new contract number.

	Maintain Contract  [page ] 18

	Change Contract End Date  [page ] 18
	Contract Specialist - Leasing
	Manage Contract - Missing translation in language EN (RECN)
	Contract end date is changed.

	New Condition  [page ] 19
	Contract Specialist - Leasing
	Manage Contract - Missing translation in language EN (RECN)
	New condition is set.

	Change Condition  [page ] 21
	Contract Specialist - Leasing
	Manage Contract - Missing translation in language EN (RECN)
	Condition is set.

	Change Customer  [page ] 27
	Contract Specialist - Leasing
	Manage Contract - Missing translation in language EN (RECN)
	The new customer is saved.

	Contract Management Fiori App  [page ] 29

	Create Contract  [page ] 29
	Contract Specialist - Leasing
	Contract Management
	Contract end date is changed.

	Change Contract End Date  [page ] 32
	Contract Specialist - Leasing
	Contract Management
	New condition is set.

	New Condition  [page ] 34
	Contract Specialist - Leasing
	Contract Management
	Condition is set.

	Change Condition  [page ] 35
	Contract Specialist - Leasing
	Contract Management
	Contract valuation is edited.
Contract changes are saved.

	Periodic Posting

	Individual Process

	Periodic Posting - Simulation  [page ] 37
	Accounts Receivable Accountant - Leasing
	Periodic Posting: Contracts - Missing translation in language EN (RERAPP)
	Period posting is simulated.

	Periodic Posting – Execution  [page ] 39
	Accounts Receivable Accountant - Leasing
	Periodic Posting: Contracts - Missing translation in language EN (RERAPP)
	Period posting is posted.

	Adjustment

	Free Adjustment

	Free Adjustment - Simulate  [page ] 40
	Contract Specialist - Leasing
	Manage Contract - Missing translation in language EN (RECN)
	Manage Contract Transaction: Adjustment is simulated

	Free Adjustment - Execute  [page ] 42
	Contract Specialist - Leasing
	Manage Contract - Missing translation in language EN (RECN)
	Manage Contract Transaction: Adjustment is performed

	Index Adjustment

	Index Adjustment – Simulate  [page ] 44
	Contract Specialist - Leasing
	Manage Contract - Missing translation in language EN (RECN)
	Manage Contract Transaction: Adjustment is simulated

	Index Adjustment – Execute  [page ] 46
	Contract Specialist - Leasing
	Manage Contract - Missing translation in language EN (RECN)
	Manage Contract Transaction: Adjustment is performed

	(J78_OP) Advanced Cash Operations   [page ] 48
	
	
	The cash flow reports are displayed.

	(1XV_OP) SAP S/4HANA for Enterprise Contract Management  [page ] 48
	
	
	The leasing data can be integrated with Legal Content Management.

	Report Contract

	Report Contracts Overview  [page ] 50
	Contract Specialist - Leasing
	Contracts - Information System (REISCN)
	The report view displays.

	Report: Business Partners for Contracts  [page ] 51
	Contract Specialist - Leasing
	Business Partners of Contracts - Information System (REISCNBP)
	The report view displays.

	Report: Objects for Contracts  [page ] 52
	Contract Specialist - Leasing
	Objects for Contracts - Information System (REISCNOA)
	The report view displays.

	Report: Term   [page ] 53
	Contract Specialist - Leasing
	Term of Contracts - Information System (REISCNPE)
	The report view displays.

	Report: Reminder Dates  [page ] 54
	Contract Specialist - Leasing
	Manage Dates for Contracts - Missing translation in language EN (RECARSCN)
	The report view displays.

	Report: Posted Documents for Contracts  [page ] 55
	Accounts Receivable Accountant - Leasing
	Item Overview - Information System (REISRADOCITEM)
	The report view displays.

	End Contract  [page ] 56
	Contract Specialist - Leasing
	Manage Contract - Missing translation in language EN (RECN)
	The contract changes are saved and the contract ended.

	Technical Transactions
	
	
	

	Cash Flow Update for Contracts - Simulation  [page ] 58
	Administrator - Leasing
	Cash Flow Update for Contract - Missing translation in language EN (RECDCGOL)
	Cash flow update for contracts is simulated.

	Cash Flow Update for Contracts - Execution  [page ] 59
	Administrator - Leasing
	Cash Flow Update for Contract - Missing translation in language EN (RECDCGOL)
	Cash flow update for contracts is executed.

	Worklist: Update Objects - Simulation  [page ] 60
	Administrator - Leasing
	Worklist: Update Objects - Missing translation in language EN (RECARG)
	Worklist: update objects is simulated.

	Worklist: Update Objects - Execution  [page ] 61
	Administrator - Leasing
	Worklist: Update Objects - Missing translation in language EN (RECARG)
	Worklist: update objects is executed.

	Analyze Logs  [page ] 62
	Administrator - Leasing
	Analyze Logs - Missing translation in language EN (RECALA)
	Logs are analyzed.

	Archive Contract  [page ] 63
	Contract Specialist - Leasing
	Manage Contract - Missing translation in language EN (RECN)
	Contract is archived.


[bookmark: unique_44][bookmark: _Toc51146356]Test Procedures
This section describes test procedures for each process step that belongs to this scope item.
[bookmark: unique_12][bookmark: _Toc51146357]Create Contract
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can create a new contract as part of your daily business.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing．
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN).
	The Contract screen displays.
	

	3
	Create Contract
	Choose Create Object.
Make the following entries and choose Continue.
Contract Type: <Lease out contract type>, for example, Lease Out Real Estate
Company Code: 1010
	Data is validated, next screen General Data screen displays.
	

	4
	Insert general Data
	Make the following entries and choose Partner.
Contract Currency: EUR (As defaulted)
The company code currency is defaulted here. It’s allowed to be changed to a different currency.
Contract name: <Your contract name>
Valuation Relevance: No Leasing Valuation
	Data is validated.
The Partners screen displays.
	

	5
	Assign New Partner
	Choose Assign New Partner.
Choose Customer (Fin.Accounting).
Make the following entries and choose Continue.
Business Partner: 10100001
	Data is validated.
	

	6
	Insert Term
	Choose Term.
Make the following entries:
Contract start date: <Your contract start date>
1st Contract end: <Your contract end date>
Choose Enter and choose Continue in Correct Cash Flow From view.
	The data is validated and Cash Flow From date is filled.
The Term has been created.
	

	7
	Insert contract objects
	Choose Objects.
Choose Assign to link a contract object to the contract.
Contract object: <Your description of the contract object>, for example, COB
Object type: <Select a contract object type>
Account assignment: <Select a cost center for a account assignment> for example, CTR A000/10101101
	Data are validated.
The Object screen displays.
	

	8
	Insert contract conditions
	Choose Conditions.
Choose Insert Condition(s) to select the Condition Type of your contract.
For each condition make the following entries:
Unit Price: <Your unit price of the condition>
Currency: <your contract currency>
The currency in Contract Currency of tab General Data is defaulted here. It is allowed to be changed to a different currency.
Under Terms, choose Display or Change Term for Posting.
If a foreign currency is used in Contract Currency in tab General Data or in Currency of tab Condition, select a currency translation rule in below field.
CrcyTrRule: <Select a rule>
Tax Group: <your default tax group>, for example, Y-FULL
Default tax group can be set by SSC-UI Default Value for Tax Rate per Contract Type as described in chapter Prerequisites - Default Value for Tax Rate per Contract Type.
Choose Continue.
Under Terms, choose Display or Change Term for Organization Assignment and enter the following data:
Profit Center: <Select a profit center> for example, YB600
Functional Area: <Select a functional area> for example, YB40
The Profit Center and Functional Area entered here should be matched with the values in cost center master data, which is entered in Account Assignment of tab Objects in the contract.
Choose Continue.
Choose Simulate to simulate the cash flow.
Choose Back to Conditions.
When tax group Y-FULL and jurisdiction code is selected, a statistical condition with the tax amount with the same condition type has to be created:
Make sure the contract type, object type and condition type are matched. For example, if contract type is Lease out Real Estate, condition type should be YCO01 Land/Property or YCO02 Building, condition type should be RE land or RE building related.
	Data are validated.
Cash flow can be simulated
The Resubmission screen displays.
	

	9
	Insert critical dates and reminders for contract
	Choose Resubmission.
Choose the Create Reminder Rule to create a reminder rule for your contract.
For each reminder rule make the following entries:
Reminder Rule: <Select a reminder rule>
Resubmission Reason: <Select a reason>
Date: <Enter a date in the future>
Then choose Save and go to the next screen.
	The reminder rule is generated.
The contract is saved and the number of the new contract is released.
	

	10
	Activate Contract
	Choose Activate to activate your contract.
Choose Yes.
	A message to execute the activation is shown. The contract is activated.
	


[bookmark: unique_13][bookmark: _Toc51146358]Maintain Contract
In the Manage Contract app, you can make changes on the contract. Below are some examples for typical changes for the Leasing process.
[bookmark: unique_14][bookmark: _Toc51146359]Change Contract End Date
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can change an existing contract as part of your daily business.
Procedure
To execute this activity go step by step through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN).
	The Contract screen displays.
	

	3
	Process Contract
	Make the following entries and choose Change Object:
Company Code: 1010
Contract: <Your contract>
	Data is validated, next screen General Data screen is displayed.
	

	4
	General Data
	Check the entries and choose mark the Tab Term.
	The Term screen is displayed.
	

	5
	Insert new Term
	Change the following entries and choose Enter and go to the next screen:
1st Contract End: <Your new contract end date>
	The date is updated.
	

	6
	Save contract
	Choose Save.
	Data is validated.
	


[bookmark: unique_15][bookmark: _Toc51146360]New Condition
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can change an existing contract as part of your daily business.
Procedure
To execute this activity go step by step through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN).
	The Contract screen displays.
	

	3
	Process Contract
	Change to change mode. Make the following entries and choose Change Object:
Company Code: 1010
Contract: <Your contract>
	Data is validated, next screen General Data screen is displayed.
	

	4
	General Data
	Check the entries and choose mark the Tab Conditions. Choose Conditions and go to the next screen.
	The Conditions screen is displayed.
	

	5
	Insert new condition
	Choose Insert Condition(s) to select the new conditions of your contract.
For each condition make the following entries:
Unit price: <Your unit price of the condition>
Choose Simulate to simulate the cash flow.
	Data is validated.
Cash flow can be simulated
	

	6
	Save contract
	Choose Save.
	Data is validated.
	


[bookmark: unique_16][bookmark: _Toc51146361]Change Condition
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can change an existing contract as part of your daily business.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN).
	The Contract screen displays.
	

	3
	Process Contract
	Make the following entries and choose Change Object.
Company Code: 1010
Contract: <Your contract>
	Data is validated, next screen General Data screen is displayed.
	

	4
	General Data
	Check the entries and choose the tabs Conditions and Enter to go to the next screen.
	The Conditions screen is displayed.
	

	5
	Change Conditions
	Select the condition you want to change.
Make the following entries:
Valid From: <Your new valid from date of the condition>
Unit Price: <Your unit price of the condition>
Choose Simulate to simulate the cash flow.
Then choose Enter.
	Data is validated.
Cash flow can be simulated.
	

	6
	Save contract
	Choose Save.
	Data is validated.
	


[bookmark: unique_45][bookmark: _Toc51146362]Renew Contract
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can renew an existing contract as part of your daily business.
Procedure
To execute this activity go step by step go through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN).
	The Contract screen displays.
	

	3
	Real Estate Contract
	Make the following entries and choose Change Object:
Company Code: 1010
Contract: <Your contract>
	Data are validated, next screen General Data screen is displayed.
	

	4
	Insert Renewal
	Choose Term.
Choose Create Term, then choose Renewal.
Make the following entries:
Renewal Type: 2 Individual Renewal Rule and choose Append Row.
Option/Automatic: Option
Seq: <1>
Number: <1>
RnwYrs: <3>
NtfY: <1>
Choose Save.
Choose Back.
Choose Change Object to activate the renewal when decision is made to renew the contract.
Choose Renew Contract.
Choose Approve and Activate.
Choose Save.
Another option is to renew the contract automatically.
Option/Automatic: Automatic
Seq.: <2>
Number: <1>
RnwYrs: <3>
NtfM: <6>
	Data are validated.
The contract is renewed.
	

	6
	Save Contract
	Choose Save.
	Data is validated.
	


[bookmark: unique_46][bookmark: _Toc51146363]Add Notice
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this activity, you can create a notification for your contract objects.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log onto Fiori Launchpad
	Log onto the SAP Fiori launchpad as a
Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN).
	The Contract screen displays.
	

	3
	Process Contract
	Make the following entries and choose Change Object:
Company Code: 1010
Contract: <Your contract>
	Data are validated, next screen General Data screen is displayed.
	

	4
	Add Notice on Objects
	Choose Term.
Choose Create Term, then choose Notice on Objects.
Make the following entries:
Renewal Type: 2 Individual Notice Procedure
Choose Create Notice Rule, then choose Individual Period Regulation.
Make the following entries:
Party Giving Notice: 9 Both
Notice Per: 01 End of Month
Consider Minimum Term: <select>
Earliest Notice On: <Today>
Choose Simulate to go to the next screen.
Choose Close to close Simulate Notice.
Choose Continue.
Choose Object Assignment and choose Assign Object from Contract.
	Data are validated.
The Notice is added.
	

	5
	Save Contract
	Choose Save.
	Data is validated.
	



To execute notice on contracts.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log onto Fiori Launchpad
	Log onto the SAP Fiori launchpad as a
Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Notice on Contracts – Information System.
	The Information System: Giving Notice on Contracts screen displays.
	

	3
	Activate Notice
	Make the following entries and choose Execute to go to the next screen:
Company Code: 1010
Contract: <Your contract>
Contacts w/ No Notice Given: <select>
Select the contracts in Company Code Column, then choose Activate Notice and make the following entries in the next screen.
Notice Per: <Today>
Reason for Notice: <90>
Choose Continue.
Choose Save.
	Notices are activated.
	


[bookmark: unique_17][bookmark: _Toc51146364]Change Customer
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can change a customer of an existing contract as part of your daily business.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN).
	The Contract screen displays.
	

	3
	Process Contract
	Make the following entries and choose Change Object.
Company Code: 1010
Contract: <Your contract>
	Data is validated, the General Data screen displays.
	

	4
	Change Partner
	Choose Partners.
Make the following entry for old customer:
End of relationship: <Your end of relationship date>
Ignore the warning message There are gaps in assignment of required role FLCU00 Customer (Financial Accounting.
Choose Assign New Partner. Choose Customer(Fin.Accounting).
Make the following entries in Business Partner Search screen:
New Customer: 10100002
Choose Continue.
Choose Copy.
Ignore the error message No more than 001 partners can be assigned in role FLCU00 at the same time.
Make the following entry:
Start reltnship: <Your Start of relationship date>
	Data is validated.
	

	5
	Change Conditions
	Choose Conditions.
Under Terms, choose Display or Change Term for Postings.
Choose Show time dependence.
Choose New: Add validity period.
Valid from: <Your Start of relationship date>
Partner: <the new customer>
Choose Continue.
Choose Simulate to simulate the cash flow.
	Data is validated and new customer appears in the cash flow.
	

	6
	Save Contract
	Choose Save to save your contract
	
	


[bookmark: unique_18][bookmark: _Toc51146365]Contract Management Fiori App
[bookmark: unique_19][bookmark: _Toc51146366]Create Contract
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can create a new contract as part of your daily business.
Procedure
To execute this activity go step by step go through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a
Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Contract Management Fiori app.
	The Contract Management screen displays.
	

	3
	Create a new contract
	Create a new contract by selecting the Add a new Contract button +.
	A selection page is displayed.
	

	4
	Add a new Contract
	Make the following entries and press Save and go to the next screen:
Company Code: 1010
Contract Type: <Lease out contract>
Contract Number: filled in automatically
Contract Name: Optional, less than 80 characters
Start date: <today's date>
End date: <today's date + 2 years>
	Data are validated.
The Contract Management screen is displayed.
	

	5
	Create Renewal
	Make the following entries and press Save:
Select the Add Renewal button + and fill in the required fields:
Make the Renewal type selection: Automatic
Select from the drop-down list the needed type of automatic renewal: One or more repetitions
Fill in the number of the months renewal: <for example:3>
Renewal number of times: <for example:3>
Month end notification: <for example:1>
	Data is validated.
The Renewal is displayed on the timeline.

	

	6
	Simulate Renewal
	Select the Simulate Renewal button.
	Data is displayed automatically based on your previous selection
	

	7
	Create Break Option
	Select Add Break Option, Add new Break Option is displayed and fill in the required fields.
NoticeRuleName: <Break Option's name>
Giving Notice: <For example:Both>
Notice Per: <Select a date>
Receipt to: <Select a date>
	Data is validated.
The Break Option details screen is displayed.
	

	8
	Assign new Partners
	Select the All Partners button and press Add - +.
Once the Add new Partner Assignment window is displayed, fill in the required fields and Save.
Business Partner Role: Customer (Financial Accounting)
Business Partner: <Business Partner number>
Address Type: <Standard Address>
	Data is validated.
The new Partner is created.
	

	9
	Insert contract objects
	Select the Add + button and fill in the required fields :
Object Type: Contract Object
Name: <Name>
Object Type: <Select one Object type from the list>
Accounting Object Type: <Cost Center>
Select a valid cost center
Valid From: <today's date>
No End Date: Deselect
Valid To: <Select a date>
Then press Save.
	Data is validated.
The Contract Object is created.
	

	10
	Insert contract conditions
	Select the Add + button and fill in the required fields:
Under Condition Type
Condition Type: <Your Condition Type>
Under Condition
Ext. Cond. Purp.: <Select a Condition purpose>
Calc. Formula: <Select the Calculation Formula>
Unit Price: <Insert a unit price>
Currency: <Select your Currency>
Under Posting
Tax Type: <Select a Tax Type>
Tax Group: <Select a Tax Group>
Under Condition Validity
Valid From: <Today's date>
No End Date: Deselect
Valid To: <Select a date in the future>
Under Frequency
Frequency: <Your Frequency>
Frequency Unit: <Select the Frequency Unit>
Amt. Reference: <Select the Reference>
Payment Form: <Select your Payment Form>
Frequency Start: <Select your Frequency Start>
Under Partner
Partner: <Select your Partner>
*If you are working for company code 1010, make sure you select <Your Jurisdiction Code>
Choose Save.
Press simulate to simulate the cash flow.
Choose Close.
	Data is validated.
Cash flow can be simulated
	

	11
	Insert Organizational Assignment
	Select the Add + button and fill in the required fields:
Profit Center: <Insert your Profit Center> for example, YB600
Functional Area: <Insert your Functional Area> for example, YB40
The Profit Center and Functional Area entered here should be matched with the values in cost center master data, which is entered in Account Assignment of tab Objects in the contract.
Valid From: <Today's Date>
	Data is validated.

	

	12
	Insert Document
	Select the Add + button and upload your document.
	Document is uploaded and can be opened in Contract Management.
	


[bookmark: unique_20][bookmark: _Toc51146367]Change Contract End Date
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can change an existing contract as part of your daily business.
Procedure
To execute this activity go step by step go through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Contract Management .
	The Contract Management screen displays.
	

	3
	Select the Contract
	Make the following entries:
Company Code: 1010
Contract: <Your contract>
Choose Go
	The Contract Management screen displays.
	

	4
	General Data
	Check the entries, select Edit Contract Header, and go to the next screen.
	The Edit General Information screen is displayed.
	

	5
	Insert new Term
	Change the following entries and choose Enter to go to the next screen:
1st Contract End: <Your new contract end date>
	The date is updated.
	

	6
	Save contract
	Choose Save.
	Data are validated.
	


[bookmark: unique_21][bookmark: _Toc51146368]New Condition
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can change an existing contract as part of your daily business.
To reflect the sub-lease-contract during asset capitalization, it is required to enter the total amount of rent income as statistical condition(Condition type LG92) on the head-lease contract (Asset retirement). This condition will reduce the asset capitalization. Refer to below procedures for this operation.
Procedure
To execute this activity go step by step go through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Contract Management Fiori app.
	The Contract Management screen displays.
	

	3
	Select the Contract
	Make the following entries:
Company Code: 1010
Contract: <Your contract>
Choose Go
	The Contract Management screen displays.
	

	4
	General Data
	Check the entries, and choose Conditions tab.
	
	

	5
	Change your existing conditions
	Go to your Condition Type and select the pen.
On the Edit Condition display you can make the needed changes and Save.
	Data are saved.
	

	6
	Insert new condition
	Choose Edit Condition for the new conditions of your contract.
For each condition make the following entries:
Unit price: <Your unit price of the condition>
Choose Simulate to simulate the cash flow.
Choose Save.
	Data are validated.
Cash flow can be simulated
	


[bookmark: unique_22][bookmark: _Toc51146369]Change Condition
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can change an existing contract as part of your daily business.
Procedure
To execute this activity go step by step go through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Contract Management .
	The Contract screen displays.
	

	3
	Process Contract
	Make the following entries:
Company Code: 1010
Contract: <Your contract>
Choose Go
	Data are validated, the General Data screen displays.
	

	4
	General Data
	Check the entries and select the Conditions tab.
	The Conditions screen displays.
	

	5
	Change Conditions
	Select the pen in order to edit the conditions you want to change for your contract.
Make the following entries:
Unit price: <Your unit price of the condition>
Valid from: <Your new valid from date of the condition>
Choose Simulate to simulate the cash flow.
Then choose Enter.
	Data are validated.
Cash flow can be simulated
The Valuation parameters screen displays.
	


[bookmark: d2e2686][bookmark: _Toc51146370]Periodic Posting
[bookmark: d2e2687][bookmark: _Toc51146371]Individual Process
[bookmark: unique_23][bookmark: _Toc51146372]Periodic Posting - Simulation
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can simulate the periodic posting of an existing contract as part of your daily business.
Procedure
When a contract is posted, it is useful to first simulate the posting
To execute this activity go step by step go through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as an Accounts Receivable Accountant - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Periodic Posting: Contracts - Missing translation in language EN (RERAPP).
	The Periodic Posting: Contracts screen displays.
	

	3
	Periodic Posting: Contracts Selection
	Make the following entries and choose Execute.
Company Code: 1010
Contract: <Your contract>
Contract Type: YO10 or YO50 (Lease Out Contract Type)
Month for Posting Run: <First month of the start date of your contract>
Year for Posting Run: <Year of the start date of your contract>
Posting Run Mode: <Simulation>
Type of Posting Run: <Integrated posting>
	Data are validated, the Periodic Posting: Contract screen displays.
	

	4
	Periodic Posting Contract
	Check the posting and choose Documents.
	Postings are green.
The Documents screen is displayed.
	

	5
	Periodic Posting Contract: Documents
	Check the documents (accounts, cost elements) and choose Back to go back.
	Postings are correct.
The Periodic Posting: Contract screen is displayed.
	

	6
	Periodic Posting: Contract
	Choose Back to go back.
	
	


[bookmark: unique_24][bookmark: _Toc51146373]Periodic Posting – Execution
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can execute the periodic posting of an existing contract as part of your daily business.
Procedure
To execute this activity, go step by step through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Logon
	Log onto the SAP Fiori launchpad as an Accounts Receivable Accountant - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Periodic Posting: Contracts - Missing translation in language EN (RERAPP)
	The Periodic Posting: Contracts view displays.
	

	3
	Periodic Posting: Contracts Selection
	Make the following entries and choose Execute:
Company Code: 1010
Contract: <Your contract>
Contract Type: YO10 or YO50 (Lease Out Contract Type)
Month for Posting Run: <First month of the start date of your contract>
Year for Posting Run: <Year of the start date of your contract>
Posting Run Mode: Update Run
Type of Posting Run: Integrated posting
	Data validates and the Periodic Posting: Contract view is displayed.
	

	4
	Periodic Posting Contract
	Check the postings and choose Documents.
Go to the next screen.
	Postings are green and Documents view is displayed.
	

	5
	Periodic Posting Contract: Documents
	Check the Documents (accounts and cost elements) and choose Back to go back.
	Postings are correct.
The Periodic Posting: Contract screen is displayed.
	

	6
	Periodic Posting: Contract
	Choose Back.
	
	


[bookmark: d2e2886][bookmark: _Toc51146374]Adjustment
[bookmark: d2e2887][bookmark: _Toc51146375]Free Adjustment
[bookmark: unique_25][bookmark: _Toc51146376]Free Adjustment - Simulate
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you adjust the condition of an existing contract as part of your daily business.
Procedure
To execute this activity go step by step go through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN).
	The Manage Contract screen displays.
	

	3
	Process Contract
	In screen Contract, make the following entries and press Enter:
Company Code: 1010
Contract: <Your contract>
Choose Change Object.
	Data are validated, next screen General Data screen is displayed.
	

	4
	Simulate Adjustment
	Choose Adjustment.
Choose Create Term to select the adjustment rule Free – Modifiable to your contract.
Choose Conditions next to Free - Modifiable.
Choose Assign Free Condition(s) to assign one of the conditions of the contract.
Choose Save.
Choose Simulate Adjustment. Make the following entries and choose Continue in screen Adjustment Parameters.
Next possible valid from date: activate
Adjustment reason: Standard
In screen Parameters of Free Adjustment, input one of the parameter for free adjustment and choose Continue.
In screen Adjustment Record, choose Continue.
In screen Adjustment Data for Condition, choose Continue.
	Data are validated and calculation is correct.
	


[bookmark: unique_26][bookmark: _Toc51146377]Free Adjustment - Execute
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Procedure
To execute this activity go step by step go through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN).
	The Manage Contract screen displays.
	

	3
	Process Contract
	In screen Contract, make the following entries and press Enter:
Company Code: 1010
Contract: <Your contract>
Choose Change Object.
	Data are validated, next screen General Data screen is displayed.
	

	4
	Execute Adjustment
	Choose Adjustment.
Choose Conditions.
Choose Execute/Continue Adjustment. Make the following entries and choose Continue in screen Adjustment Parameters.
Next possible valid from date: activate
Adjustment reason: Standard
In screen Parameters of Free Adjustment, input one of the parameter for free adjustment and choose Continue.
In screen Adjustment Record, choose Activate adjustment.
Choose Execute Simulation.
In screen Simulate Condition Adjustment, choose Continue.
In screen Adjustment Record, choose Continue.
	Data are validated and calculation is correct.
	

	5
	Save Contract
	Choose Save to save your contract in screen Adjustment Data for Condition.
	Data are validated and adjustment is performed.
	


[bookmark: d2e3086][bookmark: _Toc51146378]Index Adjustment
[bookmark: unique_27][bookmark: _Toc51146379]Index Adjustment – Simulate
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you adjust the condition of an existing contract as part of your daily business.
Procedure
To execute this activity go step by step go through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN).
	The Manage Contract view displays.
	

	3
	Process Contract
	In the Contract view, make the following entries:
Company Code: 1010
Contract: <Your contract>
and choose Change Object.
	Data is validated and the General Data view is displayed.
	

	4
	Simulate Adjustment
	Choose Adjustment.
Choose the Create Term icon and select the adjustment rule Index - Modifiable Germany for your contract.
Choose Unlink from Customizing icon and maintain your data.
Min. Change Pts: <your point>
Min. Percent: <your percent>
Either input values for one of those fields or ignore the warning message Adjustment XX: the minimum change fields are not filled.
If point is maintained in Min. Change Pts, please make sure the point maintained here is less than the difference between the points of the index series for the current date and the index level for the date the last time the condition was adjusted (Both points are maintained by SSC-UI Enter Index Levels in Preliminary Steps).
If point is maintained in Min. Percent, please make sure the percent maintained here is less than the percentage difference between the points of the index series for the current date and the index level for the date the last time the condition was adjusted (Both points are maintained by SSC-UI Enter Index Levels in Preliminary Steps). The percentage difference is calculated on the basis of this absolute difference, using the following formula: difference * 100 / (index level at last adjustment).
Index Start: <The first date of index level>
First adjust. from: <Today>
Remaining in Adjustment, choose Conditions.
Choose Assign Free Condition(s) to assign one of the conditions of the contract.
Choose Save.
Choose Simulate Adjustment. Make the following entries and choose Continue in view Adjustment Parameters.
Valid From: <Today is recommended>
Adjustment reason: Standard
In the Parameters of Free Adjustment dialog box, input one of the parameter for free adjustment and choose Continue.
In the Adjustment Record dialog box, choose Continue.
In the Adjustment Data for Condition dialog box, choose Continue.
	Data is validated and the calculation is correct.
	


[bookmark: unique_28][bookmark: _Toc51146380]Index Adjustment – Execute
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Procedure
To execute this activity go step by step go through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN).
	The Manage Contract screen displays.
	

	3
	Process Contract
	In the Contract view, make the following entries and choose Change Object:
Company Code: 1010
Contract: <Your contract>
	Data are validated, the General Data view is displayed.
	

	4
	Execute Adjustment
	Choose Adjustment.
Under Adjustment, choose Conditions.
Choose Execute/Continue Adjustment. Make the following entries and choose Continue in the Adjustment Parameters dialog box.
Next Possible Valid-From: <select>
Adjust. reason: Standard
In the Adjustment Record dialog box, choose Activate adjustment.
Choose Execute Simulation.
In the Simulate Condition Adjustment dialog box, choose Continue.
In screen Adjustment Record, choose Continue.
	Data are validated and calculation is correct.
	

	5
	Save Contract
	Choose Save to save your contract in screen Adjustment Data for Condition.
	Data are validated and adjustment is performed.
	

	6
	Insert a new valuation time slot
	Choose Valuation Parameters.
In the Numbers row, choose Show Time-Dependence, then choose Add Validity Period in the Valid row.
Make the following entries to insert a new valuation time slot to the selected valuation rule.
Valid From: <the valid from date of index adjustment> and Continue.
Choose Rule complete to complete the valuation rule.
Please ignore the warning message Valuation is pending and still needs to be completed.
	Data are validated and calculation is correct.
	


[bookmark: unique_29][bookmark: _Toc51146381](J78_OP) Advanced Cash Operations
Purpose
This section describes the frequently used reports for cash daily operation related with Contract and Lease Management.
Procedure
The procedure is described in the Advanced Cash Operations (J78) scope item. Please complete following 2 test procedures for that scope item.
Check Cash Flow Items
Cash Flow Analyzer
[bookmark: unique_30][bookmark: _Toc51146382](1XV_OP) SAP S/4HANA for Enterprise Contract Management
Preliminary Steps
Contract and Lease Management is integrated with Enterprise Contract Management. If Enterprise Contract Management is activated, you can use Enterprise Contract Management for Contract and Lease Management. To achieve this, below two steps need to be performed via SSCUI.
In order to carry out the following activities, a business user with a business role must exist. The business role SAP_BR_BPC_EXPERT must be assigned to the user.

	Sequence
	Configuration UI
	Description
	Expected Result
	Pass / Fail / Comment

	1
	Define Linked Object Types
	Types of objects which are used in Context/Legal Transaction apps as links (for navigation).
	The SAP Fiori Launchpad displays.
	

	2
	Define Profiles
	Profiles for Context/Legal Transaction apps for restriction visibility of data sets (Internal/External Contacts, Entities, Linked Objects…)
	The Location Management app displays.
	


Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log onto Fiori Launchpad
	Log on to the SAP Fiori launchpad as a Configuration Expert.
	The SAP Fiori Launch Pad displays.
	

	2
	Open Manage Your Solution
	Open Manage Your Solution.
	The Manage Your Solution screen displays.
	

	3
	Open Configure Your Solution
	Choose Configure Your Solution.
	The Configure Your Solution screen displays.
	

	4
	Search and Open Define Linked Object Types
	Search and open Define Linked Object Types.
Click New Entry, input below parameters and save it.
Linked Object Type: Your Linked Object Type for example, 0012
Long Text: Contract and Lease Management
Lnk. Obj. Tech. Type: RECN
Integration Link: Choose Real Estate Contract from drop-down list
You may be asked to enter a customizing request number, either choose your own customizing request or create a new one, then choose Continue.
	The linked object type for Contract and Lease Management is created
	

	5
	Go back to Configure Your Solution
	Go back and open Configure Your Solution.
	The Configure Your Solution screen displays.
	

	6
	Search and Open Define Profiles
	Search and open Define Profiles.
In Define Sets screen, Choose Prf. Set: G5, Double click Linked Objects,
Click New Entry, input below parameters and save it.
LObj. Set: G5
LnkObj. Ty: Your Linked Object Type created in step 4
You may be asked to enter a customizing request number, either choose your own customizing request or create a new one, then choose Continue.
	You linked object type for Contract and Lease Management is added in profile
	


Purpose
SAP S/4HANA for Enterprise Contract Management connects processes, content, technology, and people in legal departments. It provides a central layer for legal contract and an integrated platform for legal technology.
Procedure
The procedure is described in the SAP S/4HANA for Enterprise Contract Management (1XV) scope item. Please complete all the procedures for that scope item before proceeding.
[bookmark: d2e3483][bookmark: _Toc51146383]Report Contract
[bookmark: unique_31][bookmark: _Toc51146384]Report Contracts Overview
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you run a report of existing contracts as part of your daily business.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Contracts - Information System (REISCN).
	The IS: Contracts screen displays.
	

	3
	Report Contract
	Make the following entries and choose Execute.
Company Code: 1010
Contract: <Your contract(s)>
Use Grid Control: <select>
	Data is shown.
	


[bookmark: unique_32][bookmark: _Toc51146385]Report: Business Partners for Contracts
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you run a report of existing contracts as part of your daily business.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Business Partners of Contracts - Information System (REISCNBP).
	The IS: Business Partners of Contracts screen displays.
	

	3
	Report Contract
	Make the following entries and choose Execute.
Company Code: 1010
Contract: <Your contract(s)>
Use Grid Control: <select>
	Data is shown.
	


[bookmark: unique_33][bookmark: _Toc51146386]Report: Objects for Contracts
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you run a report of existing contracts as part of your daily business.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Objects for Contracts - Information System (REISCNOA).
	The IS: Objects for Contracts screen displays.
	

	3
	Report Contract
	Make the following entries and choose Execute:
Company Code: 1010
Contract: <Your contract(s)>
Use Grid Control: <select>
	Data is shown.
	


[bookmark: unique_34][bookmark: _Toc51146387]Report: Term
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you run a report of existing contracts as part of your daily business.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Term of Contracts - Information System (REISCNPE).
	The Information System: Term of Contracts screen displays.
	

	3
	Report Contract
	Make the following entries and choose Execute.
Company Code: 1010
Contract: <Your contract(s)>
Use Grid Control: <select>
	Data is shown.
	


[bookmark: unique_35][bookmark: _Toc51146388]Report: Reminder Dates
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you run a report of existing contracts as part of your daily business.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Dates for Contracts - Missing translation in language EN (RECARSCN).
	The Process Reminder Dates for Contracts screen displays.
	

	3
	Report Contract
	Make the following entries and choose Execute.
Company Code: 1010
Contract: <Your contract(s)>
	Data is shown.
	


[bookmark: unique_36][bookmark: _Toc51146389]Report: Posted Documents for Contracts
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can create a new contract as part of your daily business.
Procedure
To execute this activity go step by step through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as an Accounts Receivable Accountant - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Item Overview - Information System (REISRADOCITEM).
	The Item Overview displays.
	

	3
	Report Contract
	Make the following entries and choose Execute.
Company Code: 1010
Contract: <Your contract(s)>
Use Grid Control: activate
	Data is shown.
	


[bookmark: unique_37][bookmark: _Toc51146390]End Contract
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can end an existing contract as part of your daily business.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN).
	The Contract screen displays.
	

	3
	Real Estate Contract
	Make the following entries and choose Change Object.
Company Code: 1010
Contract: <Your contract>
	Data is validated, the General Data screen is displayed.
	

	4
	End contract
	Choose Term.
Make the following entry and choose Enter:
1st Contract End: <Your contract end date>
	Data is validated.
	

	5
	Save
	Choose Save to save your contract.
	
	


[bookmark: d2e4178][bookmark: _Toc51146391]Technical Transactions
[bookmark: unique_38][bookmark: _Toc51146392]Cash Flow Update for Contracts - Simulation
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can simulate the update of the cash flow of existing contract as part of your daily business.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as an Administrator - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Cash Flow Update for Contract - Missing translation in language EN (RECDCGOL).
	The Generation of Cash Flows for Contracts screen displays.
	

	3
	Cash Flow Update for Contracts Selection
	Make the following entries and choose Execute.
Company Code: 1010
Contract: <Your contract(s)>
Simulation: activated
	Data is validated, next screen Cash Flow Generation for Contract screen displays.
	

	4
	Cash Flow Update for Contracts
	Analyze data.
	Data is shown.
	


[bookmark: unique_39][bookmark: _Toc51146393]Cash Flow Update for Contracts - Execution
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can execute the cash flow of an existing contract as part of your daily business.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as an Administrator - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Cash Flow Update for Contract - Missing translation in language EN (RECDCGOL).
	The Generation of Cash Flows for Contracts screen displays.
	

	3
	Cash Flow Update for Contracts Selection
	Make the following entries and choose Execute.
Company Code: 1010
Contract: <Your contract(s)>
Simulation: deactivate
	Data is validated, next screen Cash Flow Generation for Contract screen is displayed.
	

	4
	Cash Flow Update for Contracts
	Analyze data.
	Data is shown.
	


[bookmark: unique_40][bookmark: _Toc51146394]Worklist: Update Objects - Simulation
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can simulate the update of the contracts as part of your daily business.
The prerequisite of this testing procedure is to create a contract, save it but not activate it.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as an Administrator - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Worklist: Update Objects - Missing translation in language EN (RECARG).
	The Update Objects in the Worklist screen displays.
	

	3
	Worklist: Update Objects Selection
	Make the following entries and choose Execute.
Person responsible: <Own user ID>
Display Selection List: selected
	Data is validated, the Worklist: Update Objects screen displays.
	

	4
	Worklist: Update Objects
	Analyze data.
	Data is shown.
	


[bookmark: unique_41][bookmark: _Toc51146395]Worklist: Update Objects - Execution
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can execute the update of the contracts as part of your daily business. The prerequisite of this testing procedure is to create a contract, save it but not activate it.
Procedure
To execute this activity go step by step go through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as an Administrator - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Worklist: Update Objects - Missing translation in language EN (RECARG).
	The Worklist: Update Objects screen displays.
	

	3
	Worklist: Update Objects Selection
	Make the following entries and choose Execute.
Person responsible: <Own user ID>
Update Immediately: <selected>
	Data is validated, next screen Update Objects in the Worklist screen is displayed.
	

	4
	Worklist: Update Objects
	Analyze data.
	Data is shown.
	


[bookmark: unique_42][bookmark: _Toc51146396]Analyze Logs
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can analyze logs as part of your daily business.
Procedure
To execute this activity go step by step through the table.
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as an Administrator - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Analyze Logs - Missing translation in language EN (RECALA).
	The Analyze Logs screen displays.
	

	3
	Analyze Logs
	Make the following entry and choose Execute.
User: <Own user ID>
	Data is validated, next screen Log Display screen is displayed.
	

	4
	Worklist: Update Objects
	Analyze data.
	Data is shown.
	


[bookmark: unique_43][bookmark: _Toc51146397]Archive Contract
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Context
In this activity, you can archive an existing contract as part of your daily business. A contract can only be deactivated and archived, when the contract is not posted yet.
Procedure
To execute this activity go step by step go through the table.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log onto the SAP Fiori launchpad as a Contract Specialist - Leasing.
	The SAP Fiori launchpad displays.
	

	2
	Access the SAP Fiori app
	Open Manage Contract - Missing translation in language EN (RECN)
	The Manage Contract screen displays.
	

	3
	Real Estate Contract
	Make the following entries and press Enter:
Company Code: 1010
Contract: <Your contract>
	Data are validated, next screen General Data screen is displayed.
	

	4
	Real Estate Contract
	Go to: More – Contract – Activation and Term – Deactivate
Confirm the message.
	Message: Status was changed
	

	5
	Real Estate Contract
	Go to: More – Edit – Change Status – Archive – Set Deletion Flag.
Confirm the message.
	Message: Status was changed
	

	5
	Save
	Press Entry to save your contract
	
	




Typographic Conventions
	Type Style
	Description

	Example
	Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options.
Textual cross-references to other documents.

	Example
	Emphasized words or expressions.

	EXAMPLE
	Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.

	Example
	Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.

	Example
	Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.

	<Example>
	Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.

	EXAMPLE
	Keys on the keyboard, for example, F2 or ENTER.
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